Trajectories 2024 — Mapping the Census of Canada

This workshop has been prepared by MacOdrum Library GIS Services (gis@carleton.ca).

Mapping the Census of Canada can be a great way to visualize and analyze census data. However,
navigating the Stats Canada website can be tricky and data tables often require cleaning, merging, and a
lot of digging around. Thankfully, while you are an active Carleton member (student, staff, or faculty)
you have access to an amazing tool called the Canadian Census Analyser. We have some excellent help
guides that will walk you through using this tool.

Before we begin, open your P:drive and create a new folder called MappingCensusCanada. This will be
your project folder where you will save your data and your project.

We will attempt to answer the following question: What City of Ottawa census tracts have the highest
public transit ridership for commute to work?

Part 1. Getting the data

1. Go to GIS Help: Mapping the Census of Canada | MacOdrum Library (carleton.ca). Click on What
are census geographies to get an idea of the type of geography you want to map. For this
exercise, we will choose one of the smallest census geographies — census tracts.

a. Click on Census of Canada: Downloading Canadian Census Analyser Data | MacOdrum
Library (carleton.ca) | Click on Canadian Census Analyser website, hosted by the
University of Toronto link| you will be prompted to sign in using your MyCarletonOne
credentials

b. On the Canadian Census Analyser page, click on 2021 under “by Census Year.”

On the next page, click on Profile of Census Tract

2. On the Canadian Census Analyser 2021 Census Profile page, you will go through a series of Steps
to choose the geography and variables you want to map.

a. Stepl: Specify Census Geography for retrieval | click on the by Province tab | check
Ontario| click on the by Name tab and check the letter “O” | you will see 2 items found,
check Ottawa — Gatineau (Ont.)
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Stepi: Specify Census Geography for retrieval

= Census Geography: (1 selected)

@® Locate census geography (CMAs/CAs with CTs) in the

by Name | by Province

Oa OsUOc0Op UOe OF Oc
O OkOLOmON®Eo Op
o Or Os O1 Ov Cw

|
2 items found:
[J Oshawa (Ont.)

Ottawa - Gatineau (Ont.)

|
Selected items:
Ottawa - Gatineau (Ont.)

b. Step2: Specify Census Profile variables for retrieval | let’s look at some of the variable
options | We are interested in population and commute to work
i. first click on the Population and dwellings tab and check the following:

1.

2.
3.
4,

Population, 2021

Population, 2016

Population percentage change, 2016 to 2021
Population density per square kilometre

Population and dwelling
counts

Population and dwellings | Age & sex Dwelling F.H.M.
Mobility Minority Official Language

Population and dwelling counts

Population, 2021 (v1)

Population, 2016 (v2)

Population percentage change, 2016 to 2021 (v3)
] Tetal private dwellings (v4)

[CJ Private dwellings occupied by usual residents (v5)
Population density per square kilometre (va)

[J Land area in square kilometres (v7)

ii. Next, click on the Journey to Work tab and check the following:

1.

ok wN

Car, truck or van ; Both sexes (v7338)

Car, truck or van - as a driver ; Both sexes (v7339)
Car, truck or van - as a passenger ; Both sexes (v7340)
Public transit ; Both sexes (v7341)

Walked ; Both sexes (v7342)

Bicycle ; Both sexes (v7343)



Car, truck or van ; Both sexes (v7338)
Car, truck or van - as a driver ; Both sexe
Car, truck or van - as a passenger ; Both
Public transit ; Both sexes (v7341)
Walked ; Both sexes (v7342)
Bicycle ; Both sexes (v7343)

Other method ; Both sexes (v7344)
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c. Step3: Specify the output details and submit query
i. check all the options as it’s always helpful to have a little more information in
our table...and we will need some of this information!

Step3: Specify the output details and submit query

= Qutput details:

Optionally include in the result:

Province code & Province name
CMA code CMA name

Census Tract name

ii. Skip to Select output format and choose to Download to a file as a CSV file.
Note this is important! Census tract names are a code with leading and trailing
zeros. When outputting to a CSV those leading and trailing zeros can disappear
—especially when adding the CSV to a GIS software. We will do some work to
make sure our leading and trailing zeros remain in tact.

iii. Click on Submit Query

3. After you submit your query you will be redirected to the Data Request Summary page. There

will be two links: Data file and Header file. You will need both.

a. Click on the Data file to download the data

Right click on the Header file to Save link as the file as a .txt file in your project folder.
Copy the Data file from your downloads into your project folder
Rename the CSV to something meaningful like OttawaCommuteData
Make a second copy of the Data file and call it OttawaCommuteDataraw (you will not
work with this data! It’s just a back up copy in case things go wrong — good GIS practice!)
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4. Downloading Census Tract Boundaries from Stats Canada
a. Go to the Stats Canada website homepage - Statistics Canada: Canada's national
statistical agency (statcan.gc.ca)
b. Click on the Geography tab in the top ribbon
Click on the drop down menu for Spatial information products and click on Boundary
files
d. Click on the 2021 Census year
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e. Scroll down on the next page to the Boundary files options and choose the following
options using the radio buttons:
i. Language — English
ii. Type — Cartographic Boundary Files
iii. Format — Shapefile (.shp)
iv. Statistical boundaries — Census tracts
v. Click Continue
f. The next page there will be a download link to your zipped boundary shapefile. Click on
the link to begin the download

Alternative format - ZIP document

The following document is available for downloading or viewing:

e |ct 000b21a e.zip (ZIP version, 13,089.0 kb),

g. Copy the downloaded zipped folder into your project folder and unzip/extract the folder
— right-click on the folder and choose Extract All and Extract. Rename the unzipped
folder CensusTracts
5. Go to Open Ottawa and type in Ward in the search box. Select Wards 2022-2026. Click
download. Hopefully, you will see choices for download such as CSV, Shapefile, etc. Download
the Shapefile (if the website is not loading properly, we have made all the data available for
download here). Copy the Wards_2022-2026 shapefile from your downloads into your project
folder. Make sure to unzip/extract the folder.

Part 2: Prepping data and adding it to QGIS
Note, this is where the majority of our time will be spent — data prep!

6. Open the CSV and make sure our COL5 that contains our Census Tracts is in tact. When you
open the CSV excel may ask you if you want to convert COL5 to numeric, choose do not convert!
Click on the F column to highlight the entire column. Right-click on the F and choose Format cells
from the menu. Change the Category from General to Text. Save your CSV.

Format Cells ? X

Mumber  Alignment Font Border Fill Protection

Category:

General sample
Number
Currency
Accounting Text format cells are treated as text even when a number is in the cell.
Date The cell is displayed exactly as entered.

COLs

Percentage
Fraction
Scientific
Text
Special
Custom
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7. We can change the field headings in the CSV using our Header file as reference. Open your
header text file. Use the headers to create very short, meaningful field headings in your CSV.
QGIS only allows a certain number of characters for field headings. Use the following example to
change your field headers. When you are finished, save the CSV.

COLO = GEOUID
COL1 = PROV_NUM
COL2 = PROV

COL3 = CMA_NUM
coL4 =CMA
COL5=CT

COL6 = POP_2021
COL7 = POP_2016
COL8 = POP%CHANGE
COL9 = POP_DENS
COL10 = VEH_DRIVE
COL11 = VEH_PASS
COL12 = TRANSIT
COL13 = WALK
COL14 = BIKE
COL15 = OTHER

8. Note the first row has very large numbers. This is not a single census tract. Instead, it represents
all of the Ottawa CMA. For this exercise we do not require this row. Right click on row 2 and
delete it to shift the rows up.

A B C D E F G H
1 [GEOUID PROV MU PROV CMA NUM CMA CT POP 2021 POP 2016 P
2 |_ 5050000 35 Ontario 505 Ottawa - €0000.00 1488307 1371576
o SASAART A 3E Fimtari ENE Mt £AANT NA a9EE a7

9. Scroll to the bottom of the CT column and note that there are 5 values that are not configured
the same as the others. We need to add decimal places to these CT values. Click on each one
and edit them to add .00 at the end of the values. 1000 should be 1000.00, 1001 should be
1001.00...etc. The decimal place values should stick since we changed our column to Text.

Save and close the CSV. Now we are ready to add the CSV to QGIS!

10. Search for QGIS in the lab computer start menu. Launch QGIS 3.4. Where it says Project
Templates, double-click on New Empty Project to start a new project.

11. There are a couple of ways to bring in data to a QGIS project.
a. Inthe top ribbon, click on the Layer tab, hover over Add layer, and choose Add
Delimited Text Layer...




IEVEY Settings Plugins Vector Raster Database Web Mesh Processing Help

Il % Data Source Manager Ctrl+L W - |
2l 9
Create Layer »
A
Add Layer » \/: Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... Fu Add Raster Layer... Ctrl+Shift+R

Add from Layer Definition File...
j:t Georeferencer...

B4 Add Mesh Layer..

« Add Delimited Text Layer... Ctrl+Shift+T
'u Add PostGIS Layers... Ctrl+Shift+D
/7, Add Spatialite Layer... Ctrl+Shift+L
B Add MS SQL Server Layer...

Copy Style
Paste Style

Copy Layer

12. You can browse to your project folder and locate the CSV using the three-dot browse menu —
beside File name.
a. File format is CSV.
Record and Fields, only check First record has field names.
Leave Detect field names unchecked!
Geometry Definition — choose No geometry.
Preview your table to ensure the CT column is still text (string). All columns should,
currently, be Text (string). We want certain columns to be numeric or integer. Side scroll
to POP_2021 column and change the field type to integer (32 bit). Do this for all the
number columns to the right of POP_2021 except for POP%CHANGE and POP_DENS -
these two columns should be Decimal (double) as they have decimal places.
f.  Once everything looks correct (image below), click Add at the bottom of the box. Then,
click Close to close the Data Source Manager box.

® a0 o

Manager | Delimited Text - [m] X
“ File name C:\Users\meaghankenny\DesktopTrajectories20 24MappingCensusCanada\OttawaCommuteData. csv a
Layer name OttawaCommuteData Enceding | UTF-8 -
w File Format

. €SV (comma separated values)
Regular expression delimiter

Custom delimiters

w Record and Fields Options

Number of header lines to discard 0 = Decimal separator is comma
V| First record has field names Trim fields
Detect field types Discard empty fields

Custom boolean literals

True False

w Geometry Definition

Point coordinates
Well known text (WKT)

. No geometry (attribute only table)

w Layer Settings

Use spatial index Use subset index Watch file
Sample Data
CcT POP_2021 POP_2016 POP%CHANGE POP_DENS VEH_DRIVE |*
abe Text (string) ~ | 123Integer (32bit) ~ | 123Integer (32bit) ~ | abc Text (string) 1.2 Decimal (double) ¥ | 123Integer (32 bit]
1 |0001.04 2863 2718 123 Integer 32 bit) 21163 425
2 | 0001.05 5882 5084 123 |nteger (64 bit) |2204.6 1345
3 D001.06 6083 6111 | Decma..ouble) |Gey 1305
d‘ non1.07 an75 4193 t/f Boolean 4182.9 94n . 4
Date
G Time
= Date & Time Close [ add | Help




13. Right-click on the newly added OttawaCommuteData file and click on Open Attribute Table from
the drop down menu. Always check your data to make sure everything was added correctly.

14. Now we can add our Census Tracts (these will be for all of Canada). This time we will drag and
drop the file into our map viewer. Navigate to the location of your CensusTracts folder and
locate your census tract shapefile. The shapefile will be named something like
Ict_000b21a_e.shp. Click on the Ict_000b21a_e.shp

=

MName

Ict_000b21a_e.dbf
|| let_000b21a_e.prj
Ict_000b21a_e.shp
b3 Ict_000b21a_e.shx
L 1ct_000b213_exml

Trajectories2024MappingCensusCanada » CensusTracts

Date modified Type

DEF File
PRI File
SHP File

DWG TrueView Co...

Microsoft Edge H...

Size

324 KB
TKB
27,705 KB
43 KB

43 KB

Drag the shapefile into your map viewer to display the census tracts.

R
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15. Add a basemap as a reference layer so we can see that our census tracts are showing up in the
right place. In the Browser panel, on the left hand side, Scroll to the XYZ Tiles and drop down the
menu. Select OpenStreetMap by double clicking on the item. It should load into your map
viewer. If your census tracts disappear, it may be due to the Open street map layer being on top.
You can change the hierarchy of layers in your Layers panel on the left hand side.

« I ® T 7 9 e
V! [ 1ct_000b21a e

» V| i OpenStreetMap
==| OttawaCommuteData

v ZEE XYZ Tiles R & [
Mapzen Global Terrain % s
22 OpenStreetMap “& %
@ wcs R g, ) %
/) WFS / OGC API - Features = o
Layers B®




16. Open the attribute table for the shapefile to inspect the data. Right-click on the Ict_000b21a_e
layer and Open Attribute Table. Note that the CTNAME field has the census tracts with the
leading and trailing zeros. Later we will use this column to perform a join to the matching CT
column in our OttawaCommuteData table.

17. The census tract shapefile is for all of Canada and we only want census tracts for the Ottawa-
Gatineau CMA. The CTUID is combination of the CMA code and the CT code to create a unique
identifier code. Right click on the OttawaCommuteData table and open the attribute table to
see the CMA code for Ottawa (hint —it’s 505!). We now know that Ottawa CTUID’s will start with
505. We will perform a select by expression to select only CT’s for Ottawa-Gatineau CMA from
our shapefile table. Close the OttawaCommutedata table.

a. Inthelct_000b21a_e layer attribute table click on the tiny select by expression icon.

[
¥ b

CTUID
1 2050001.00

A AT O

DGuID
2021505072050...

N1 COCAT AN

) Ict_000b21a_e — Features Total: 6247, Filtered: 6247, Selected: 0

LT E 0]
| Select features using an expression [
0001.00 5.7029 (12

OON o0

21007 A

2 B = 8 &G
PRUID

b. Inthe Select by Expression box, in the middle panel, click on Fields and Values. Double
click on the CTUID field — this will add it to the expression panel on the left-hand side. In
the right-hand panel, in the Values search box type 505 and click on All Unique. A list of
unique CTUID’s starting with 505 should list in the section below All Unique. Double
click on one of the values to add it to the expression panel. To ensure we are only
selecting CTUID’s that start with 505, we will change our expression to read: “CTUID”
Like ‘505%’ . The percent sign acts as a wild card so we will get CTUID’s that start with
505 and have unique endings. Click on Select Features in the bottom right corner.

Lad et 000b21a_e — Select by Expression
Expression Function Editor
=) Ll
TUID" Like '505%"
= I =
Feature |0001.00 =
Preview: 0
Help

{rT vy v v

rrTrrrrrvrvrow

feature =

geometry
id
Aggregates
Arrays
Color
Conditicnals
Conversions
Date and Time
Fields and Values
feature
geometry
id
MNULL
abc CTUID
abe DGUID
abe CTNAME
1.2 LANDAREA
abc PRUID
Files and Paths
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math
Operators

Rasters -

Double-click to add field name to expression
string.

Right-Click an field name to open context
menu sample value loading options.

Loading field values from online sources isn't
supported before the layeris actually
inserted, ie. when building queries

values L 50§

All Unique 10 Samples
5030001.04 =
5030001.05
5030001.06
5030001.07
5030001.08
5030001.09
5030001.10
5030002.01
5030002.02
5030002.04
5030002.05
5050002.06
5050003 00N b

€ select Features |~ Close




18.

19.

Your shapefile attribute table should show 315 features have been selected. That’s the
same number of CT’s in our OttawaCommuteData table. Great! Close the Select by
Expression box.

In the attribute table you can show only the selection by clicking on Show Selected
Features in the bottom left corner of the table. Additionally, you can see at the top of
the attribute table that there are 315 selected features. Perfect!

/

(2} Ict 000b21a_e — Features Total: 6247, Filtered: 315, Selected: 315

|| Show Selected Features

Q= @ 08 s VT E @ P P E

CTUID DGuID CTMAME = LAMDAREA PRUID

35383

e.

Close the table.

In the layers panel, right click on the Ict_000b21a_e shapefile, click on Export, click on Save
Selected Features As...

} MS SOL Serve SET Layer scale Visibiity... \
@ Oracle Layer CRS 4
£ WMSANMTS Save Features As..,
AYErs Styles . d
=3 n_@ . K Add Layer Notes.., Save as Layer Definition File...
OttawaCom Properties... Save as QGIS Layer Style File..
v

Ict 000blia e _ RIS T " P—
V| B OpenStreetMap /\_.\\ oo )(

In the Save Vector Layer as... choose the following:

a.
b.

ESRI Shapefile for the Format,

For File name, use the three-dot menu to browse to your project folder to save your
new shapefile and name it OttawaGat_CT, leave the rest of the default settings (see
image below).

Click OK.



k! Save Vector Layer as...

Format ESRI Shapefile

File name  ers\meaghankenny\Desktop\Trajectories 20 24MappingCensusCanada'\OttawaGat_CT.shp

Layer name
CRS EPSG:3347 - MADS3 [ Statistics Canada Lambert
Encoding UTF-8

v Save only selected features
b Select fields to export and their export options

v | Persist layer metadata
w Geometry

Geometry type Automatic

> Extent (current: none)

w Layer Options

RESIZE | NO

SHPT

b Custom Options

v | Add saved file to map oK Cancel

Help

We can now remove the Ict_000b21a_e file from our layer panel. The OttawaGat_CT should be the only

shapefile. Right click on the layer and click on Remove layer.

Part 3: Preparing and Performing a Join — Joining the data table to the cartographic boundaries

20. Right-click on OttawaGat_CT layer and click on Properties. In the Layer Properties panel click on
Attributes Form to see more details about the attributes. We can see the CTNAME column is

text. This is good as it will be our join column.

10



b, 4
]

() Layer Properties — Ict_000b21a_e — Attributes Form

Q Autogenerate
"? Information = Available Widgets
a * Fields
W Source abe CTUID
- abe DGUID
& Symbology
abc CTMAME
€I Labels 1.2 LANDAREA
abc PRUID
€D Masks Relations
Actions

Ng 3D View

Diagrams QML Widget

B rieios

-] Attributes
= Form

Joins

Auxiliary

ﬂ Storage

=

+ (Other Widgets

HTML Widget

21. We can also perform our join from the Layer Properties panel.

a.

]

Click on Joins.

Click on the little green plus sign at the bottom of the right hand panel.

Join layer will be your OttawaCommuteData table.

Join field will be CT

Target field will be CTNAME. Note that they are both text (abc).

Check Custom field name prefix and remove the text from the box. Click OK.

Click Apply on the bottom right. It will look like nothing happened! Click OK and close
the Layer Properties box.

11



22.

23.

24.

25. In the top ribbon click on Vector. Hover over Geoprocessing Tools. Click on Dissolve

L9

Information
} Source
Symbology

Labels

ENS

3D View

. Diagrams

B rieios

E Attributes Form

0‘ Joins

ﬁ Auxiliary Storage
{® Actions
- Display
. .
& Rendering
G- Temporal

Variables

,II.'I Elevation
E Metadata

ﬁ Dependencies

Setting Value

(2 Add Vector Join

=
Join layer OttawaCommuteData
Join field abe CT
Target field | abec CTNAME
v | Cache join layer in memary
Create attribute index on join field
Dynamic farm
» Editable join layer
> Joined fields
¥ +/ Custom field name prefix
OK Cancel

OK

Right-click on the OttawaGat_CT layer and open the attribute table. Inspect the data table to see

that all the data table values have joined successfully.

When inspecting our map we can see that the CMA for Ottawa-Gatineau covers more area than
we actually want for our area of interest. We only want data for the City of Ottawa. Almonte,

Arnprior, Russel and the Quebec side of the CMA are not required for this exercise. We will use
our Ottawa Ward_2022-2026 boundary file to perform two geoprocessing actions: dissolve and

clip.

Add the Wards 2022-2026 shapefile to your QGIS project, choose one of the methods we
previously used — drag and drop or Layer, Add Vector Layer

12



Databasze

Raster

Web Mesh Processing Help

Geoprocessing Tools

w

Geometry Tools

Analysis Tools b
Research Tools 4
Data Management Tools b

™ Buffer...

& Clip...

@ Convex Hull...
B Difference..

‘@ Intersection..,
P Syrmmetrical Difference...

i Union...

¥ Eliminate Selected Polygons...

shto

.

Ao

26. We just want the outline or boundary of the City of Ottawa so we will dissolve the ward

boundaries.

a. Inputlayer is Wards_2022-2026.

b. Click on the three-dot menu and choose Save to File.

c. Save your dissolved file in your project folder as Ottawa_Dissolved.
d

Click on Run.

Q Diszolve

Parameters Log

Dissolve

Input layer
| ) Wards_2022-2026 [EPSG:4326]

e A

Selected features only
Dissolve field(s) [optional]

|D field(s) selected | |:|

P Advanced Parameters

This algorithm takes a vector layer and combines
their features into new features. One or more
attributes can be specified to dissolve features
belonging to the same dass (having the same
wvalue for the specified attributes), alternatively all
features can be dissolved in a single one.

All output geometries will be converted to multi
geometries. In case the input is a polygon layer,
common boundaries of adjacent polygons being
dissolved will get erased.

Dissolved
If enabled, the optional Keep disjoint features
|[Create temporary layer] | |j separate” setting will cause features and parts
e . et orted as
v | Open output file after running algorithm Create Temporary Layer single

Save to GeoPackage...

Save to Database Table...

Change File Encoding (System)...

[ 0%

Cancel

| Advanced = | |Run as Batch Process...

Run | | Close | Help |
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The result should be added to the map and should have no ward boundary lines. Remove the
Wards_2022-2026 layer from your Layers panel.

27. Click on Vector in the top ribbon. Hover over Geoprocessing Tools. Click on Clip.

Web Mesh Processing Help

Raster Database

Geoprocessing Tools

Geometry Tools 4

Analysis Tools v | @ Convex Hull..

Besearch Tools ¥ | g Difference...

) sktop\Tra
Data Management Tools ¢ | i Dissolve.,

‘@ Intersection..,
2 Symmetrical Difference...

@ Union...

P Eliminate Selected Polygons...

‘\"». \///

28. In the Clip box enter the following:
a. OttawaGat_CT for the Input layer.
b. Enter OttawaDissolved for the Overlay layer.
c. ForClipped, Click on the three-dot menu to Save to file and save the file to your project
folder and call it CityofOttawaCT_Commute. Make sure the file type is shapefile.

14



@ clip

Parameters Log c"p

Input layer This algarithm dlips a vector layer
— = I features of an additional polygon
[~ OttawaGat_CT [EP5G:3347] - l&“ll tk} = parts of the features in the Input

within the polygons of the Cverlay
Selected features only added to the resulting layer.

Overlay layer The attributes of the features are|

— = i il although properties such as area
| OttawaDissolved [EPSG:4326] M I_Q‘Q_I k} = features will be modified by the di
If such properties are stored as a
Selected features only attributes will have to be manually
Clipped

ctories 20 24MappingCensusCanada/CityofOttawaCT_Commute.shp

oo

v | Open output file after running algorithm Create Temporary Layer

Save to File...

Save to GeoPackage...

Save to Database Table...

Change File Enceding (Systemn)...

| 0%

Advanced ~ | |Run as Batch Process... Run Close

There should now be a CityofOttawaCT_Commute layer in your layer panel and in the map viewer. You
should see all the census tracts for the City of Ottawa. Remove the OttawaDissolved from your layers
panel.

Part 4: Symbology!

Now, we are ready to apply symbology to visually represent an analysis. With the variables we have
chosen there are many questions we can answer by applying symbology, such as:

- CT’s with high or low population change since the last census
- CT’s with high or low population density
- CT’s with high or low numbers of people that rely on cycling to work

For this exercise, we will apply symbology to look at CT’s with high number of public transit commutes to
work.

29. Right click on the CityofOttawaCT_Commute layer and click on Properties to open the Layer
Properties box. Click on Symbology

30. In the top drop down menu, change the symbology from Single Symbol to Graduated. For Value,
choose TRANSIT. For Color ramp, change the color scheme to one of your choosing. I'm
choosing greens. For mode, choose Natural Breaks (jenks).

15



hute — Symbology *

]| :-Graduahed - lA

Value |123 TRANSTT

-][€]
I

Symbol

Legend format |%1— %2 | |ecision ( €4 |$| V| Trim

Color ramp |

B
| Classes | Histogram

Symbol ¥ Values Legend
v |:| 0.00-60.00 0-60
60.00 - 140.00 60 - 140
. 140.00 - 230.00 140 - 230
. 230.00 - 350.00 230 - 350
[ | 350.00 - 545.00 350 - 545

<L s S

Mode IHEuNamraI Breaks (Jenks) - I

Classes |:|§|
| cessty || = || pektes | | Advanced - |
V| Link dass boundaries
b laver Rendarinn [~
o sy - o || cancd |[Tmemy [ rep |

31. Inspect the map. What can you see?
a. Abighole in the centre? Why?
i. Inspect the data in the attribute table. Are there any Null values?
ii. Does anyone live in this area of the greenbelt?
iii. How would you adjust the data table to “fill in” the hole?
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b. To fix the hole, we need to replace the Null values with 0’s. Open the attribute table for
the CityofOttawaCT_Commute layer. In the top left corner, click on the little pencil to
toggle editing on.

L CityofOttawaCT_Commute — Fea

[l
L4 —

|T|:|ggle editing mode (Ctrl+E) P
1 15050003.00 | 2021505075050,

Scroll to the Null values and click on the cell to replace the Null with 0.

0.6 0 0 0 0 0 0

snnnnnnnn cae [21 o= —n o n as

When you are finished replacing the Null values, Save your edits and toggle editing off
using the icons in the top left corner of the attribute table

L CityofOttawaCT_Commute — Featu

ar AL

abc cTUID | S@ve edits (Ctrl+5) |h-c

GECQUID PROV_MUM
c. Seemingly low public transit ridership for commute to work in 2021? Why?

i. Run the exercise again with data from 2016 to see if there was a big change
ii. Isitdue towork from home protocols or decrease in transit quality?

Part 5: Bonus material! Adding Labels and Creating a Layout

Label Your Map

To better visualize our census data, we’ll use different colours and labels for our map. Before doing so,
we’ll adjust how our column headers look, since the column names aren’t clearly labelled.

Create Field Alias

1. Right click on the CityofOttawaCT_Commute layer and select Properties...

2. Click on the Attributes Form tab
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3. You will see a list of all the fields. Click on the TRANSIT field and input text in the Alias field to
something helpful for your audience. For example, “Public transit ridership for journey to work”.
Click on the CTNAME field and make the Alias field “Census Tract.” Click Ok when done.

ityofOttawaCT_Commute — Attributes Form X

") Autogenerate = | | # | | Show Form on Add Feature {global settings) ~

Availa.ble Widgets w General
= Fields

abe CTUID

Alias Census Tract
abc DGUID
1.2 LANDAREA v Editable Reuse last entered value Label on top
abc PRUID
abc GEQUID w Widget Type

4. Now let’s label each Census Tract with the number of the TRANSIT field.
a) In Layer Properties box, select the Labels tab.
b) Select Single Labels for this layer and set the Value to Public transit ridership for journey
to work the value will show up as TRANSIT.
c) Choose your label font. In the example it’s Arial, size 12, bold, black. I like to apply a
Buffer as well to make the text pop.
d) Click Apply and OK to close the Layer Properties box.

ute — Labels
o [ Single Labels - || @

value | 123 TRANSIT || €

v TextSample

Lorem Ipsum

Lorem Ipsum # | |1u3ssss0 |~ | (K| M

Font [ai .

"™ Fo rmatting
#B& Buffer Style | Regular -

o MEEAEIRE! B & |7

. Background
o Shadow Size 12,0000 Iy

abe
/ Callouts hoints

q

4.
@ % Placement

/ Rendering  Color |

]

ha@aaddm @

Opadity 100.0 %

1

Allow HTML formatting

Creating a Map Layout

1. Start off by right-clicking the layer you want to create a layout for, and select Zoom to layer.
In the top ribbon, click on the Project tab and click on New Print Layout.
3. Inthe Layout title dialog box, give your new composition a name. Ottawa Public Transit
Ridership for Journey to Work 2021 by Census Tract. Click OK.
4. A new Layout window will appear. To add your map of Ottawa, click Add Item from the

top ribbon menu and click on Add Map, then draw a box that is just inside the perimeter of
the page.

N
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Adding Other Map Elements

Adding a Legend

1. Inthe menu, select Add Item > Add Legend.

2. Draw a box where you would like your legend to appear.
3. By default, all the layers on the map will appear as legend items in the legend.
4,

To remove a legend item, select the legend, and the Item Properties panel should appear on the

right hand side of the page. Uncheck the Auto update checkbox. You should then be able
manually remove the layers you don’t want in your legend using the red minus button. When
you are finished with your changes, click on Update All.

v Legend Items

Auto update

* 9 CityofOttawaCT Commute
0-60

60 - 140
140 - 230
230 - 350
350 - 545

= B OpenStreetMap

Only show items inside linked map

Only show items inside current atlas feature

Update All

Adding a North Arrow

1. Inthe menu, select Add Item > Add North Arrow.
2. Draw a box where you would like to see your north arrow.
3. Inthe Item properties panel on the right, click on the SVG browser submenu, and click on

Arrows.

4. Select an arrow that meets your needs. You could always design your own if you feel creative, or
just go for a Star Trek vibe (never a bad idea):
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Adding a Scale Bar

1. Inthe menu, select Add Item > Add Scale Bar.

Draw a box where you would like to see the scale bar.

In the Item properties tab, you can select one of six styles under the Style dropdown.
Choose the units for the scale bar under Units.

Adjust the segments in the Segments area.

ukwnN
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a. E.g.:left 0 and right 4 on a Line Ticks Up style will look something like this:

0 250 500 750 1000 km
L 1 1 1 |

6. Click and drag the scale bar into place on your map.

Adding a Title to a Map
1. Inthe menu, select Add Item > Add Label.
2. Draw a box where you'd like your title to be (you can move it later).
3. Type your title into the Main properties text box.

Export the Map
1. When your ready to export your map, click on Layout > Export as Image or Export as
PDF.
2. Select the name for your output map and click ok.
3. Your map should now be saved as an Image or a PDF.

20



